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INTRODUCTION 
 
Software Overview: 
The Electoral Boundary Tool (EBT) is an internet based mapping software which provides 
Returning Officers (RO) the ability to review and assess their Electoral District. The EBT 
consists of map layers and tools. Several map layers can be turned on and off allowing the RO 
to view additional reference information to help in their assessment and analysis. The tools 
available in the EBT allow the RO to define and edit the polling division boundaries and 
determine how many registered electors live within each polling division as well as areas which 
the RO defines. Other tools allow the RO to find addresses, get driving directions and perform 
drive times analysis. This document provides the user with all the information regarding the EBT 
and can be used as a user manual. 

The EBT can be accessed from any computer which has internet access. The web address or 
URL of the EBT is: https://nsgi.novascotia.ca/ens_viewer/ 

 

Accessing the Electoral Boundary Tool 
Accessing EBT Using ENS Computer: 
Computers provided to you by ENS should have an Electoral Boundary Tool favorite already 
saved within Internet Explorer.  
Step 1: Open an Internet Explorer window. 
Step 2: In the Internet Explorer window, click on the Favorites menu item. In the drop-down 
menu which appears, select the Electoral Boundary Tool. The EBT login page will appear. 
Step 3: Follow the login instructions below to enter the EBT site. 
 
Accessing EBT from Non-ENS Computer: 
Step 1: Open an Internet Explorer window. 
Step 2: In the Internet Explorer window, enter the below website address or URL into the 
website address input box at the top of the Internet Explorer window: 
https://nsgi.novascotia.ca/ens_viewer/ The EBT login page will appear. 
Step 3: Follow the login instructions below to enter the EBT site. 
 
Login to EBT: 
Step 1: Log into the website using the user name and password provided to you with your date 
of birth to gain access to the tool. (See Figure 1)  

The format of your user name is: edxx-userx (xx is your Electoral District number, ie. ed01-
user1) 

Click the Log In button after you enter the login credentials.  The EBT will appear in the same 
window.  You will see a map of Nova Scotia. (See Figure 2) 
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Figure 1 
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EBT - Components 
 

Once you have successfully login to the system, you will see four major components of the EBT 
in the main window. (See Figure 2)  
 

- Map Window 
- Navigation Tools 
- Map Selector 
- Toolbar 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2 
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Map Window 
Within this window you will see a map of Nova Scotia and some of the surrounding provinces. 
This is the main area where you navigate and work on your boundaries.  
 

Navigation (Zoom and Pan) 
 

Zoom - EBT Navigation Tool 
  Click here to Zoom In 

 

  Click here for different scales 

 

 

  Click here to Zoom Out 

 

  Click here to get back to full extent of the province 

 

 
Zoom - Using the Mouse  

- Use mouse roller to zoom in and out. 
- Hold the Shift key down on the keyboard and click the left mouse button to create a zoom 

in box for a user specified area. 
- Double click the left mouse button to zoom in only 

 
Pan – Using the Mouse 
Hold the left mouse button down and move the mouse up, down, left, right within the map 
window to pan.  

 
Map Selector 
Function to toggle between map and satellite image and display them on the map window as 
background reference. 
 
The user navigates to the map selector menu in the EBT, and click on the Map icon if the 
background reference is currently in Satellite Image. (See Figure 3) 
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The user navigates to the map selector menu in the EBT, and click on the Satellite Image icon if 
the background reference is currently in Map. (See Figure 4) 

 

 

 

 

Figure 4         

 

EBT Toolbar 
The EBT has a number of toolbar options which contains a number of tools which allow the user 
to find electoral districts and polling divisions; find an address; edit a polling division; perform 
elector counts; determine drive times; and more.  Each tool is identified by a tool icon and its 
name in the toolbar. To access the tool, simply click on the tool icon. Each tool appears as a 
separate widget window within the main map window. A tool window can be closed when not in 
use. (See Figure 5)  

 

Figure 5 

There are 9 tools in the tool bar.  They are: 
- Select Area 
- Address 
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- Edit 
- Driving Directions 
- Voting Places 
- Print 
- View 
- Bookmarks 
- Identify 

 
The following sections provide an overview of each tool within the EBT toolbar. 

Select Area – Select By Filter 
To access a specific electoral district, polling division, or edited polling division, user accesses 
the Select Area tool. (See Figure 6)  

 

Figure 6 

Once the menu option for Select Area is selected, the Select Area widget opens. Notice that 
there are two tabs. For this part, we will select the Select By Filter tab. 

The Select by Area / Select by Filter technique displays the drop down list of the Electoral 
District look-up values, Polling Division look-up values and Edited Polling Division look-up 
values for the users to select. (See Figure 7) 
  

 

Figure 7 

Finding your Electoral District 
To locate an electoral district within the province, the user needs to go to the Electoral District 
dropdown list to access a list of all electoral districts for Nova Scotia.  

In the example below, the user selected the first electoral district in the list, 01 – Annapolis. 
Once selected from the list, the chosen district is highligted, zoomed in to the district extent and 
the electoral district details are displayed in an information window with Electoral Distict Number 
and Electoral District Name. (See Figure 8)  
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Figure 8 

Once the chosen district is highlighted, and the map is not in the correct extents of the district of 
interest, the user can choose the Zoom to on Electoral District Details information box. (See 
Figure 9) The map will then zoom to the extents of the district of interest. (See Figure 8) 

 

Figure 9 

Locating a Polling Division within an Electoral District 
To locate a polling division boundary within a specific electoral district, the user needs to select 
Polling Division in the Type of selection drop down list. (See Figure 10) 

 

Figure 10 
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To access a polling division boundary, the user are required to have an electoral district 
boundary selected, please goto the Electoral District dropdown list to access a list of all electoral 
distrists for Nova Scotia.  

In the example below, the user selected the first electoral district in the list, 01 – Annapolis. 
Once selected from the list, the chosen district is highligted, zoomed in to the district extent and 
the Electoral Distist Details are displayed in an information window with Electoral Distict Number 
and Electoral District Name. Selecting Zoom to will zoom to the extents of the selected Electoral 
District.  

Next we will find a Polling Division of interest within the selected Electoral District. Now, select a 
Polling Division of interest from the drop down list. (See Figure 9) 

 

Figure 9 

The system switch from highlighting the Electoral District to displaying and highlighting the 
selected polling division and opens a box with the Perform Calculation button, zoom to button 
and the Polling Division Info. (See Figure 10)  
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Figure 10 

Once the chosen polling division is highlighted, and the map is not in the correct extents of the 
polling division of interest, the user can click on the Zoom to button and the system zooms in to 
the extent of the polling division boundary selected. 
 

To get the elector counts information, click on the Perform Calculation button located in the 
Polling Division Details widget window. (See Figure 11) 

 

Figure 11 

The system calculates the elector count information on the polling division boundary selected, 
and display the street keys and calculation results in a form. (See Figure 12) 
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Figure 12 

 

Locating an Edited Polling Division within an Electoral District 
To locate an edited polling division boundary within a specific electoral district, the user needs to 
select Edited Polling Division in the Type of selection drop down list. (See Figure 13) 

 

Figure 13 

To access an edited polling division boundary, the user are required to have an electoral district 
boundary selected, please goto the Electoral District dropdown list to access a list of all electoral 
distrists for Nova Scotia.  

In the example below, the user selected the first electoral district in the list, 01 – Annapolis. 
Once selected from the list, the chosen district is highligted, zoomed in to the district extent and 
the Electoral Distist Details are displayed in an information window with Electoral Distict Number 
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and Electoral District Name. Selecting Zoom to will zoom to the extents of the selected Electoral 
District.  

Next we will find a Polling Division of interest within the selected Electoral District. Now, select a 
Polling Division of interest from the drop down list. (See Figure 14) 

 

Figure 14 

The system switch from highlighting the Electoral District to displaying and highlighting the 
selected edited polling division and opens a box with the Perform Calculation button, zoom to 
button and the Edited Polling Division Info. (See Figure 15)  
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Figure 15 

Once the chosen edited polling division is highlighted, and the map is not in the correct extents 
of the edited polling division of interest, the user can click on the Zoom to button and the system 
zooms in to the extent of the edited polling division boundary selected. 
 

To get the elector counts information, click on the Perform Calculation button located in the 
Polling Division Details widget window. (See Figure 16) 

 

Figure 16 

The system calculates the elector count information on the edited polling division boundary 
selected, and display the street keys and calculation results in a form. (See Figure 17) 

15 
 



  
  Electoral Boundary Tool - User Manual 
 

 

Figure 17 

To clear all your selections, please click on the Clear button located on the main selection 
widget. (See Figure 18) 

 

Figure 18 

 
Select Area – Select By Click 
Once the menu option for Select Area is selected (See Figure 6), the Select Area widget opens. 
Notice that there are two tabs. For this part, we will select the Select By Click tab. 

Once the Select By Click tab is selected, the system loads a widget with a drop down list of the 
following type of selection: (See Figure 19) 

• Electoral District 
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• Polling Division 
• Edited Polling Division 

 

 
Figure 19 
 
Finding your Electoral District 
To locate an electoral district within the province using the Select by Click option, the user 
selects Electoral District from the drop down list and click on “Click to select using a point on the 
map”. The user then clicks on the map to select a desired electoral district. (See Figure 20)  
 

 

Figure 20 

Click on the Zoom to button and the system zooms in to the extent of the chosen electoral 
district. (See Figure 21) 
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Figure 21 

 
Locating a Polling Division 
To locate a polling division using the Select by Click option, the user selects Polling Division 
from the drop down list and click on “Click to select using a point on the map”. The user then 
clicks on the map to select a desired polling division. (See Figure 22)  

 

Figure 22 
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Click on the Zoom to button and the system zooms in to the extent of the chosen polling division 
boundary. (See Figure 23) 
 

 

Figure 23 

To get the elector counts information, click on the Perform Calculation button located in the 
Polling Division Details widget window. (See Figure 24) 

 

Figure 24 
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The system calculates the elector count information on the polling division boundary selected, 
and display the street keys and calculation results in a form. (See Figure 25) 

 

Figure 25 
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Locating an Edited Polling Division 
To locate an edited polling division using the Select by Click option, the user selects Edited 
Polling Division from the drop down list and click on “Click to select using a point on the map”. 
The user then clicks on the map to select a desired polling division. (See Figure 26)  

 

Figure 26 

Click on the Zoom to button and the system zooms in to the extent of the chosen edited polling 
division boundary. (See Figure 27) 
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Figure 27 

To get the elector counts information, click on the Perform Calculation button located in the 
Polling Division Details widget window. (See Figure 28) 

 

Figure 28 

The system calculates the elector count information on the edited polling division boundary 
selected, and display the street keys and calculation results in a form. (See Figure 29) 
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Figure 29 

To clear all your selections, please click on the Clear button located on the main selection 
widget. (See Figure 30) 

 

 

Figure 30 
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Address Menu - Find your address 
In order to locate a specific address and display the point on the map, the user navigates to the 
Address menu in the EBT, and selects the “Find your address”. (See Figure 31) 
 

 

Figure 31 

The system loads a widget, displaying a box for users to type in a civic address. (See Figure 32) 
 

 

Figure 32 

Type a civic address and click the address desired from the results list that surface while typing 
or clicking on the search button. (See Figure 33) 
 

 

(Figure 33) 

The system zooms in to the selected address identified by a marker and displays a box with the 
address information, show more results button, and zoom to button. (See Figure 34) 

 

24 
 



  
  Electoral Boundary Tool - User Manual 
 

 

Figure 34 

When the user click on more results button the system displays a box with civic address 
information close by or surrounding the selected civic address. (See Figure 35) 

 

Figure 35 

 
If the map is not in the right extent for the selected address, click on the zoom to button and the 
system zooms in to the extent of the civic address selected. 
 

Edit 
This tool provides the user with the ability to split, merge and renumber polling divisions. It also 
provides the user with the ability to calculate the number of registered electors, and number of 
dwellings within an existing polling division boundary or user defined polling division boundary. 
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Please note that you can only edit the polling division boundaries in your own electoral district 
based on your login information. 

Polling Division Edit 
To access the polling division boundary editing tool, users navigates to the Edit menu in the 
EBT, and selects the “Polling Divisions Edit”. (See Figure 36) 

 

Figure 36 

The system loads a widget with the following functionalities: (See Figure 37) 

- Select 
- Clear 
- Split 
- Merge 
- Info 
- Undo 
- Redo 
- Show Original Boundaries 

   

Figure 37 

 

Select 

To start any splitting and merging, user needs to start the session by selecting a polling division. 
To split a polling division, user clicks on the select button (See Figure 38) and starts selecting a 
single desired polling division by holding on the left mouse button and drawing a square. (See 
Figure 39) 

 

Figure 38 
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Figure 39 

The selected polling division will be highlighted in light blue. (See Figure 40) 

 

Figure 40 
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To merge a polling division, user clicks on the select button and starts selecting a 2 or more 
adjacent desired polling division by holding on the left mouse button and drawing a square. (See 
Figure 41) 

 

Figure 41 

The selected polling divisions will be highlighted in light blue. (See Figure 42) 

 

Figure 42 
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Clear 

To clear any selected polling divisions, user clicks on the clear button. (See Figure 43) 

 

Figure 43 

 

Split 

This tool provides the user the ability to split a selected polling division directly in the EBT.  

To split a polling division, the user needs to select a single desired polling division, once the 
polling division is highlighted in light blue, the user needs to click on the split button (See Figure 
44) to start the splitting action. 

 

Figure 44 

To start the split, simply start by clicking outside the selected polling division and start the line 
drawing process by clicking the mouse one after another to form the line that you desired for the 
split, once you are outside the selected polling division, double click the mouse to stop the 
splitting action. (See Figure 45-47) 

 

Figure 45 

Starting just outside the selected 
polling division. 
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Figure 46  

Continue clicking to create the line 
desired. 
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Figure 47 

The selected polling division is now split into 2 polling division. (See Figure 48) 

Double click just outside the 
selected polling division to finalize 
the line and finish the splitting 
process. 
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Figure 48 

 

Merge 

This tool provides the user the ability to merge multiple selected adjacent polling divisions 
directly in the EBT. 

To merge polling divisions, the user needs to select multiple desired adjacent polling divisions, 
once the polling divisions are highlighted in light blue, the user needs to click on the merge 
button (See Figure 49) to finalize the merging action. (See Figure 50-51) 

 

Figure 49 
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Figure 50 

2 adjacent polling division was 
selected. 
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Figure 51 

 

Info 

This tool provides the user the ability to see the selected polling division’s information and also 
allows the users to rename the polling division after each edits. 

To enable the Info tool, user needs to select a single desired polling division, once the tool is 
enabled, user needs to click on the Info button to access the tool. (See Figure 52) 

 

Figure 52 

The tool will open a widget with the District No., District Name and the current Polling Division 
Number. (See Figure 53) 
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Figure 53 

To rename a polling division number after a split or merge action, please go to the info tool and 
type in the desired polling division number for the edited polling division and click save to 
complete the renaming process. (See Figure 54) The system will open a message to confirm 
your updates. (See Figure 55) 

 

Figure 54 

 

Figure 55 

**Important Note: Please always rename the polling division that was split, into a and b (i.e. 
19003a and 19003b) for better managing your polling divisions during the renumbering process. 

 

Undo 

This tool provides the user the ability to undo the actions done to the polling division prior to 
closing the edit widget. 
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To access this tool, user needs to click on the Undo button. (See Figure 56) 

 

Figure 56 

 

Redo  

This tool provides the user the ability to redo any actions that were undone to the polling division 
prior to closing the edit widget. 

To access this tool, user needs to click on the Redo button. (See Figure 57) 

 

Figure 57 

 

Show Original Boundaries 

This tool provides the user the ability to toggle on and off and see the original polling divisions 
as a reference. 

To access this tool, user needs to click on the check box beside the Show Original Boundaries. 
(See Figure 58) 

 

Figure 58 

When the check box is checked, you will see the original polling division boundary line 
underneath the edited polling division line as a reference in a green dotted line. (See Figure 59) 

 

Figure 59 
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Calculate 
The Calculate tool is an interactive map tool which provides the user with the ability to calculate 
the number of registered electors, and the number of dwellings within an existing polling division 
boundary or a user defined area.   

To access the Calculate tool, users navigates to the Edit menu in the EBT, and selects the 
“Calculate”. (See Figure 60) 

 

Figure 60 

The system loads a widget that gives the users 2 ways to select the area to perform the 
calculation: User Defined Area, and Multiple Polling Divisions. (See Figure 61) 

 

Figure 61 

Select a user defined area for calculation 

If the user wishes to perform a calculation on a specific area other than an existing polling 
division, users can select this tool and click on the “Click to start drawing” button (See Figure 
62) to start the drawing action by holding the left mouse button and drawing the specific area 
they wish to define and release the left mouse button to finalize the area. (See Figure 63-64) 
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Figure 62 

    

Figure 63      Figure 64 

The system then calculates the elector count information on the selected area, and display the 
street keys and calculation results in a form. (See Figure 65) 

 

Figure 65 
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Select multiple polling divisions for calculation 

If the user wishes to perform a calculation on an existing polling division or multiple polling 
divisions, users can select this tool and click on the “Click to start selecting polling divisions” 
button (See Figure 66) to start selection by clicking on the desired polling division. (See Figure 
67) 

 

Figure 66 

 

Figure 67 
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The system then calculates the elector count information on the selected polling divisions, and 
display the street keys and calculation results in a form (See Figure 68) once the user click on 
the “Click to calculate selected polling divisions” button. (See Figure 66) 

 

Figure 68 

 

Clear 

To clear any selected polling divisions, user defined area and calculation results, user clicks on 
the clear button. (See Figure 69) 

 

Figure 69 

 

Re-Number Polling Divisions 
This tool provides the user with the ability to re-number the polling divisions after updates were 
made to them. 

To access the Re-Number Polling Divisions tool, users navigates to the Edit menu in the EBT, 
and selects the “Re-Number Polling Divisions”. (See Figure 70) 

 

Figure 70 
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The system loads a widget that shows your electoral district, the current polling division number 
and a blank box beside each current polling division number for you to enter the desired new 
polling division number. (See Figure 71) 

 

Figure 71 

To start the re-numbering process, user types in the polling divisions that required a re-
numbering, if the New PD Number is left as blank, the system will maintain the current polling 
division number for that poll. (See Figure 72) Click Save once you are satisfied with the re-
numbering process, and the system will generate a message to confirm your action. (See Figure 
73) 

 

Figure 72 

 

Figure 73 
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When a user clicks on the blank box to start the data entry process, the system will 
automatically zoom in to the extent of that polling division for reference purposes. (See Figure 
74) 

 

Figure 74 

To clear all the user defined new polling division number, user clicks on the clear button. (See 
Figure 75) 

 

Figure 75 

 
Driving Directions 
This tool provides the user with the ability to determine a driving route, distance between, and 
drive time between the two locations.  The user can either type in the civic address, select two 
point locations on the map, or use the location service on the device. 
 
To access the tool, user navigates to the Driving Directions menu in the EBT, and click on it. 
(See Figure 76) 

 

Figure 76 

The system loads a widget with the following: (See Figure 77) 
• Starting Point 
• Destination 
• Add Destination 
• Show More Options 
• Get Directions Button 
• Clear Button 
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Figure 77 

 
The user types a civic address on both the starting and destination point and click the address 
desired from the results list that surface while typing or clicking on the Find My Location button 
(See Figure 78) if user wishes to use the location service on the device, or click anywhere on 
the map by clicking on the locator (See Figure 79) to get the desired location and click Get 
Directions. 
 

 
Figure 78 
 

 
Figure 79 
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The system will generate the shortest distance route on the map and zooms in to the identified 
route by displaying a highlighted route with the starting and destination point. 
 
The system will also generate a turn by turn routing information, distance and time information, 
with a Zoom to Full Route button, and a print button on the widget section that correspond to the 
information box on the map when you click on each routing information. (See Figure 80) 
 

 

Figure 80 
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Turn by Turn 

When users click on each turn by turn route, the system zoom in to the route and opens an 
information box with the turn by turn information and zoom to button, click on zoom to button on 
the routing information box on the map and the system zooms in more on the selected route 
information on the map. (See Figure 81) 
 

 

Figure 81 

Add Destination 
 
To add a 3rd destination users click on Add Destination button on the widget. (See Figure 82) 

 
Figure 82 
 
The system creates a new destination point for users to determine by typing the address or 
clicking on the map. 
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Add destination by typing the address. (See Figure 83) 

 

Figure 83 

Add destinations by clicking on the map. (See Figure 84) 

 

Figure 84 

 
More Options 
 
Users click on show more options on the widget to displays the following options: (See Figure 
85) 

• Return to start 
• Miles or Kilometers options 

 

 

Figure 85 

 
Miles or Kilometers 
 
The user can toggle between Miles and Kilometers for the driving distance. (See Figure 86) 
 

 

Figure 86 
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Hide Options 

Users click on hide options on the widget to minimize/hide the additional options menu. (See 
Figure 87) 
 

 

Figure 87 

Zoom to Full Route 

Users click on the zoom to full route button on the widget and the system zooms to the full 
extent of the route on the map. (See Figure 88) 

 
Figure 88 
 
Return to start 

Users click on the Return to start button on the widget and the system generates a new route 
with a return to starting point routing. (See Figure 89) 

 

Figure 89 

Reverse Directions  

Users click on Reverse Direction button (See figure 90) on the widget and the system reverse 
the start and destination point and show the new routing information on the map and turn by 
turn information on the widget. (See Figure 91) 
 

 
Figure 90 
 

 

 

Figure 91 
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Print 

Users click on the print button (See Figure 92) on the widget and the system opens a print 
preview window with the turn by turn information for user to see. (See Figure 93) 

 

 
Figure 92 
 

 

Figure 93 

Click on the print button (See Figure 94) on the print preview window and the system opens a 
printer selection list and prints the information with the selected printer. (See Figure 95) 
 

 

Figure 94 
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Figure 95  

Select the appropriate printer and select Print. 

Click on the close button on the print preview window to close the print preview window. 
 
Voting Places Menu - Service Areas 
This is a tool that provides drive time routing analysis and produce service area based on user 
defined time line. Please note that these drive time zones are approximations based on perfect 
conditions (no weather, traffic, or traffic stops). The zones should only be used as an 
approximation. 

To access this tool, users navigates to the Voting Places menu in the EBT, and selects the 
“Service Area”. (See Figure 96) 
 

 

Figure 96 

The system loads a widget, with a drop down list of “Click Point on Map” and “Enter Address as 
Text” as selections for the center point and 3 user defined drive time in minutes with a note 
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stating the range of time, the “Click to set a point and apply drive times” button, and a Clear 
button. (See Figure 97)  
 

 

Figure 97  

Service Area – Manual Point Placement  
To create a service area using manual point placement, select the Click Point on map selection 
on the Type of selection dropdown list. (See Figure 98) 

  

Figure 98 

Enter atleast one drive time and up to 3 drive times without exceeding 45 minutes in the drive 
time box and click on the “Click to set a point and apply drive times” button to start selecting a 
desired location on the map.    

Once a location is selected, the system will produce drive time analysis zones based on the 
drive time specified using the point clicked as center point, and also labels the drive time 
specified in minutes. (See Figure 99) 
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Figure 99 

If no drive times are entered, the system will return an error message. (See Figure 100)  

 

Figure 100 

If a user enters a drive time more than 45 minutes, the system will return an error message. 
(See Figure 101) 
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Figure 101 

 

To clear all your selections, please click on the Clear button located on the main selection 
widget. (See Figure 102) 

 

Figure 102 

 
Service Areas – Enter Civic Address  
 
To create a service area by entering a civic address select the Enter Address as Text selection 
on the Type of selection dropdown list. (See Figure 103) 
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Figure 103 

Enter the civic address and enter atleast one drive time and up to 3 drive times without 
exceeding 45 minutes in the drive time box and click on the “Click to search apply drive times” 
button. 

The system will produce drive time analysis zones based on the drive time specified using the 
civic address entered as center point, and also labels the drive time specified in minutes. (See 
Figure 104) 

 

Figure 104 

53 
 



  
  Electoral Boundary Tool - User Manual 
 
If no civic address is entered, the system will return an error message. (See Figure 105)  

  

Figure 105 

If no drive times are entered, the system will return an error message. (See Figure 106)  

 

Figure 106 

If a user enters a drive time more than 45 minutes, the system will return an error message. 
(See Figure 107) 

 
Figure 107 

To clear all your selections, please click on the Clear button located on the main selection 
widget. (See Figure 108) 
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Figure 108 

 
Print Menu 
This is a tool that provides user with the option to print out what you see in the map window 
area. 

To access this tool, users navigates to the Print menu in the EBT. (See Figure 109) 

  

Figure 109 

The system opens a printer selection list and prints the information with the selected printer. 
(See Figure 110) 
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Figure 110 

Click print to print the map.  

 
View Menu - Layers 
The View Menu - Layers tool identifies a list of map layers which the user can turn on and off 
and used as a reference. A map layer or grouping of map layers can be turned on and off by 
checking and un-checking the check box.  Some names in the list of layers are map layer 
grouping headings and can be expanded to show a sub list of more map layers. (each of which 
can be turned on and off) 
 
To access the layers list, user navigates to the View menu in the EBT, and selects the “Layers”. 
(See Figure 111) 
 

 

Figure 111 

The system loads a widget, displaying the list of layers for the users to turn on and off. (See 
Figure 112)  
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Figure 112 
 
Users can turn the layer on and off by clicking on the check mark beside a specific layer or layer 
group. When a user turns on the layer, the system loads the layer, displaying it on the map 
when the layer is in the right scale. When a user turns off the layer, the system unloads the 
layer, turning the layer off from the map. 
 

Bookmarks 
The tool provides the user with the ability to save or “bookmark” an area of the map which they 
have been viewing, so that they can go back to it later.  There is a predefined bookmark, which 
is Home - Nova Scotia, which is listed the Bookmarks tool window. 
 
To access the bookmarks tool, user navigates to the Bookmarks menu in the EBT toolbar, and 
click on it. (See Figure 113) 
 

 
Figure 113 
 
The system loads a widget, with a box that holds the bookmark list, Add Bookmark button and 
Clear Bookmarks button. (See Figure 114) 
 

 

Figure 114 
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Users click on “Add Bookmark” button when they need to add a holder for the current view on 
the map, and the system loads a box on the widget, for the users to define a name for the new 
bookmark, if no name is define, the system automatically assigns untitled for the bookmark and 
list the bookmark in the box with an edit and delete button beside the name of the bookmark. 
(See Figure 115) 

Please note that the Add Bookmark action stores the bookmarks via client-side cookies.  
 

 

Figure 115 

 
Managing Bookmarks 
Editing Bookmarks 

Users click on the edit button beside the name of the bookmark and the system loads a box on 
the widget, for the users to edit the name for the bookmark, if no changes were made, the 
system retains the original name of the bookmark. (See Figure 116) 

 

Figure 116 

Deleting Bookmarks 

Users click on the delete button beside the name of the bookmark and the system removes the 
bookmark from the list on the widget. (See Figure 117) 

 

Figure 117 

Clearing all Bookmarks 

Users click on the “Clear Bookmarks” button (See Figure 118) and the system loads a message 
box to confirm the removal of all saved bookmarks. (See Figure 119) 

 

Figure 118 
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Figure 119 

Click on the “OK” button and the system removes all the bookmarks listed on the widget, with 
the exception of the Home-Nova Scotia bookmark, and open a message box to confirm 
bookmarks removed. (See Figure 120) 

 

 

Figure 120 

 

Identify 
The tool provides the user with the ability to check the information of a civic address, historic RO 
office and historic polling location. 

To access this tool, the user has to zoom in to a certain scale level for this tool to be enabled. 
Once the tool is enabled, user can access this tool by navigating to the Identify menu in the EBT 
toolbar and click on it. (See Figure 121) 
 

 
Figure 121 
 
When the tool is activated, the icon turns green and you can start clicking on the civic address, 
historic RO office and historic polling location to access their information. (See Figure 122) 
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Figure 122 

 
When you click on the points of interest as mentioned above it will open an information window 
showing the detail information of the point based on the type of point selected.  

(See Figure 123 for Poll Location and RO Office) (See Figure 124 for civic address information) 

 

Figure 123 

 

Figure 124 
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